CIVIL 3D (2010) **REMEMBER TO SAVE OFTEN** 10f25

GRADING {Simple and Complex Examples}

Just like anything in Civil 3D there are multiple ways to get the same product with Grading. If you want
a down and dirty rough estimate of where daylighting will occur or some quick quantities Method 1
below works great. If you’re doing a preliminary design with some details or any final design Method 2
below is going to suite you better in the end. (Method text by Matt Sparks )

Method #1
1. Create a new Site and a new grading group. This will in turn create a new proposed surface which
drives the design.
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2. With the new empty surface created, you may now add feature lines, polylines, points, etc. to the
proposed surface and watch the design update in real-time.
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This would be the ideal situation, to have everything linked and updated in real-time. In the previous
releases there were always problems with this:

= |If the grading objects became too complex, the drawing and/or surface would become unusable.

= More grading would lead to more crashing.

= “Automatic Surface Generation” could easily cause crashing .

= Confusion between which entities take precedence, the surface data added or the grading object.
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= Infills would be required to fix holes created by the gradings.

Method #2

1. Create a site and grading group just to be able to use the daylighting portion of grading objects. Do
not turn on “Automatic surface generation”.

2. Create a proposed surface and use feature lines, points, and polylines to design the surface.

3. When daylighting is needed, use a grading object, but explode the grading object and use the
footprint polyline as a breakline in the surface.

This solution seems to yield the least amount of crashes, but it comes at a price.

= Gradings are not linked to a surface. If you need another daylighting design you must create another
grading object, explode it again, and then add it to your surface yet again (reminds me of Land
Desktop).

= More control over the surface generation, however, much less automated control.

NOTE ON SITES

Sites are a way to group things topology, a Site in Civil 3D has absolutely NOTHING to do with
location. So, what is a topology? Well, basically it’s a set of rules that govern how lines (in the case of
Civil 3D) behave as other lines change. Think of it as: Geometry that lives on the same site reacts to
each other and Geometry that lives on separate sites does not react to each other. For example, you may
be doing 2 or more different waterway designs or a manure pit and a barnyard in the same drawing. To
avoid problems with overlapping surfaces and overlapping grading schemes, Sites are used. A barnyard
could be Site 1 and the manure pit could be Site 2.

SO... if you have two different things you are grading that should not react with each other ... put them
on different sites!

NOTE ON GRADING GROUPS

A grading group is a named collection of grading features that interact with each other. Therefore you
only need 1 grading group per object you are grading. A dam for example would have 1 grading group
although you may be doing a lot of different grading criteria within that dam. In the same drawing if
you were grading a dam and a manure pit those would each have their own grading group.

5-Grading USDA-NRCS 2/23/2012



CIVIL 3D (2010) **REMEMBER TO SAVE OFTEN** 30f25

GRADING {Simple and Complex Examples}

Method 1 {Step by Step} Waste Storage Example

The existing ground surface is modeled and the floor for the pit is drawn first and the elevations are set
using the Properties dialog box.

For this example the floor of our pit is El. 90.0 (pink rectangle)

280
980

e Inthe Home Ribbon > Create Design Tab > Grading > Grading Creation Tools

0 The Grading Toolbar will open and should be familiar to those who have graded in the
past.

Set Grading Group )
Select Grading Create Grading
Set Target Surface Criteria Pull down for
more options
including Infill.
Grading Creation Tools |71l
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\ Once Grading
Group and Target
Surface are set,
they will appear in
these areas.
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0 With the tool start Left to Right
= Click the 1* button and Create a Grading Group
e The Create Grading Group dialog box will appear
0 Name the Grading Group
0 Check the “Automatic Surface Creation”
0 Check “Volume Base Surface” and make sure it is set to the
surface you want to compare it to get volumes.

|3 Create Grading Group x|
Mame:
I Manure Pit '—E‘l
Description:

|7 Automatic surface creation

¥ Use the Group Mame

Surface style:

| TRIENGLES POINTS =] [ .r|

Tessellakion spacing:
| 10,00

Tesselation angle:
| zen0'00.0"

v walume base surface

|6 G =] &
Ik I Zancel | Help |

= The second icon sets the surface your grading to, in case you need to change the
surface you just set it to.

= The big drop down in the middle lets you select from a series of preset grading
specs.

= The icon with the sun actually does the grading.
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For this example our pit is 10 feet deep and has 2:1 sideslopes to the top of the berm. The berm is 10
wide (flat), and then slopes down to the existing ground at a 3:1 slope.
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e Start by grading the floor up ata 2:1
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@‘ Create Grading

o0 Set the Grading Criteria (the pull down list) to “Grade to Relative Elevation”
0 Select the Create Grading Button
= Follow the Command Line to Select the feature (bottom of your pit)
e Say “OK” to the Create Feature Lines” dialog box
Select the grading side (the outside of our pit
Apply entire length > yes
Relative Elevation: 10
Format > Slope
Type “2” for 2:1
The manure pit will grade for you.

e Now Grade the top berm 10° with no elevation change

0 Set the Grading Criteria to “Grade to Distance”

0 Select the Create Grading Button

= Select the Feature (The outside daylight line of your pit)

Entire length > yes
Specify Distance > 10’
Format > Grade
Grade > 0.01 (grading at 0.00 can result is issues so just let it grade a tiny hair
and keep Cad Happy © )

e Now Grade the top of the berm back down to existing ground at 3:1
o0 Set the Grading Criteria to “3:1”
0 Select the Create Grading Button
= Select the Feature (the outside of your top berm)
= Apply to entire length> yes
= The pit should now be completely graded
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e To find the volume of the pit click on the “Grading VVolume Tools” on the toolbar and the VVolume
Tools toolbar will appear with the cut and fill quantities.
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e Simple changes can be done using the Editor button on the toolbar
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e You’ll notice in Toolspace there is a new surface created as well!
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Method 2 {Step by Step} Dam Example

This example is going to take a simple grading task of grading a few steps further... we’re going to
build an emergency spillway and a semicircular berm around the pipe inlet. The advantage of doing so
is being able to get accurate cut and fill volumes! Since none of our other Help Sheets cover stage
storage, | will cover that here as well.

Like everything in CAD there are multiple ways to complete the task. Challenge yourself once you learn
these steps to try new ways - then share!

STAGE STORAGE
e Start with an existing ground surface (with the contours showing).

e Draw in the Centerline of the dam embankment. Often times you will survey in “hubs” which
represent markers along the centerline of your dam embankment.

e Offset the top of the dam an appropriate amount (often between 10-15") upstream. (remember if you
use a 3D polyline you need to use the Stepped Offset)

e Click on your existing ground surface and a conceptural ribbon will appear
0 On the Surface Tools Tab > Extract Objects
= Make sure the major and minor contours are selected and hit “OK”

¢ You now can click individually on any contour line. (Your surface, which acts as a single object, is
still under the contour lines).

e [IMPORTANT: Set your existing ground surface to “No Display”
e Trim each of the contour lines that go beyond the downstream side of the offset line.

e Use the “List” command to find the area of each contour. (select your contour, type “list” at the
command line)

e Use this to enter into the “Pond” Spreadsheet to complete your dam design!

5-Grading USDA-NRCS 2/23/2012



CIVIL 3D (2010) **REMEMBER TO SAVE OFTEN** 8 of 25

GRADING {Simple and Complex Examples}

I am now assuming you have designed your dam, and you are ready to draft. If you need to grade the
slopes to find appropriate elevations to plug into the spreadsheet you can do so by following the first few
steps in this help sheet.

DRAFTING A DAM (the design used in this example is at the end of this help sheet).

e Set the elevation of your centerline to be the elevation of the top of your dam (constructed el). Many
folks like to have a crown in your dam, to do so click to add vertices at the location where you want
to specify different elevations.

e Make sure the centerline of your embankment goes beyond the elevation the top of the dam. For
example, if the top of your dam is 84.5 make sure your centerline reaches at least the 85 el. contour!
e If you need to stretch your centerline use the “lengthen” command.

¢ Offset the centerline half the distance of your embankment top width in each direction (upstream and
downstream). The top of our Example Dam is 10’ so you would offset the centerline 5’ in each
direction.

what

A oy,

v

e You will now create a grading group by going to the Home Ribbon > Create Design Tab > Grading >
Grading Creation Tools.

e The “Grading Creation Tools” toolbar will appear

Set Grading Group .
Select Grading Create Grading

SetTarget Surface  nia Pull down for

more options
including Infill.
Grading Creation Tools 11 7]
D & = | & [@ 2170SURFACE dé-|as-e-u-DD|Rg
Growup: Surface:
Once Grading

Group and Target
Surfaceareset,
they will appear in
these areas.
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e Click on the “Set Grading Group” icon
e Give the Grading Group a name (such as Dam)
e Do NOT select “Automatic Surface Creation”
e Click “OK”

e Click on the “Set Target Surface” icon
e Choose the surface you want to grade to (most likely EG)
e Click “OK”

e Click the Grading Criteria from the dropdown
e Most likely 3:1 for the frontslope and 2:1 for the backslope

e Click on the “Create Grading” icon
e If you want, you can change options in the “Create Feature Line” dialog box
e Follow the command line prompts
e Change the Grading Criteria and repeat for the other side of the dam

Your drawing should now look similar to the below left figure. The point where the fill (green lines)
meets the cut (red lines) is where your design elevation is at (the top of your dam embankment).

You can drag the endpoints of your feature lines back to the design elevation by O-Snapping to the
endpoint of the feature line, dragging the line towards the point where the cut meets the fill, and O-
Snapping to the endpoint at the cut/fill location. The end result should look like the below right figure.

\

N
"

El. 84.5
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IMPORTANT NOTE

If you added additional vertices in the top of embankment polylines, you need to go into the Feature
Line Editor (found on the Feature Line Toolbar) and edit the elevations for the top of embankment lines.

JY|ldalD|F|lsey 4
s o ;A !, R ation Edicor, . |8
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We are going to use the Dam contours to set our inlet pipe elevation and draw our semicircular berm
around the pipe inlet.

e The first step is to draw in the pipe, which will be placed perpendicular to the centerline of the dam
embankment. The design sheet states the inlet elevation (start of pipe) and the approximate length of
the pipe.

e You can start by drawing a polyline in the upstream ditch at the inlet elevation, and O-snapping
perpendicular to the dam embankment. You can then use the Lengthen command to lengthen the

line the approximate length of the pipe. If all goes well, the pipe should extend past the downstream
toe!
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e According to the Pond Standard: The semicircular berm shall be 5* from the edge of the pipe. So for
this example our riser is 3’ in diameter, that means the diameter of the semicircular berm needs to be
5+3 +5 =13".

e Draw a circle with a diameter of 13 from the pipe inlet (O-Snap to the endpoint of the polyline
that represents the riser/pipe).

e Draw a polyline from EI. 78 on one side of the circle, to El. 78 on the other side of the circle

e Trim the back of the circle

e Make sure the semicircular berm is set to the proper elevation (78.0) by using the properties
dialog box.

NOTES ON GRADING OBJECTS

CAD cannot handle grading on top of grading, therefore we are going to grade the dam in individual
pieces so the grading doesn’t overlap each together. In the end we will bring all the pieces together to
form a surface from which CAD can calculate cuts and fills.

e Using the Explode command found on the Home Ribbon in the Modify tab (looks like a box that is
exploding) (or type EXPLODE at the command line), explode the daylight lines of the grading
object.
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The daylight lines become 3D polylines.

Notice how the contour lines disappear. That is ok!

e Now Grade the semicircular berm around the pipe inlet at a 3:1
0 e Click on the 3D polyline to move the vertices to match the new daylight line of the
semicircular berm
e Erase the semicircular berm grading object.

..............................................

...............................................

IMPORTANT NOTE
If you need to add additional vertices on the 3D Polyline to be able to accurately “trace around” the new

daylight line follow these steps:

At the command line type PEDIT > Click on your Polyline you want to edit > Type E to edit > hit enter
(N) to advance around the polyline > Type | when you are ready to insert anew  vertices. If you need
to go back type P for previous vertices.

Just be sure to follow the command line the whole time or reference the Help section in CAD if you
have any questions!
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We are now going to work on drawing the Emergency Spillway. This example has a level section 13’
wide X 20’ long. If possible the entire level section should be cut into the hillside.

Placement of the level section (and the entire emergency spillway) is an art. There are many
possibilities to placing and drawing the spillway, experience and trial and error are needed. If you
don’t have experience, work with another technician or engineer for any questions you have!

e Start out by drawing a rectangle that is 20" X 13’ and set the elevation to the emergency elevation (in
this case 82.3). Then rotate and move the rectangle until it fits the site.

For this example I’m going to place the level section so ~10” of length extends upstream and
downstream from the center line of the embankment. The elevation of the level section is 82.3, so I’'m
going to make sure this is all placed in an area that is at a higher elevation so that it will need to be cut
down to be constructed.
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Next is drawing the inlet and outlet channels. We’ll start with the outlet channel. A few things to keep
in mind.
e The outlet channel needs to go past the downstream toe (you don’t want this water to wash out
the back of your dam!)
e Try to keep as straight as possible (as the site allows)

e Check to see what slope range your channel needs. This design calls for an outlet channel
between 3.8 to 13%.

e Remember this is an art!

e Start by drawing one side of the outlet channel using a 3D Polyline.
Use your O-Snaps to avoid elevations going to zero!
e Check the length
e Check the elevation difference between level section and outlet elevation
e Make sure the slope is in the proper range.
e This may take some trial and error... be patient!

This example has a length of 80.3 feet and an elevation difference of 10.3’. The slope is ~8%

g

¢ Next offset the channel the width of the emergency spillway (this example is 13’) using the Stepped
Offset command (found on Modify Ribbon > Edit Geometry Tab)

Home  Insert Arrmtemmlalyze View Output Manage Express Tools Parametric  Image |

ﬁ Survey @ Parcel "7 Alignment + Intersection M Profile View J J 4_,, +_,‘\ 1_){ J
dﬁ? Points _'_,}" Feature Line I Profile % Assembhy EJ —h sample Line et Delets FI _'_,}" HI a0 S I
@ Surface @ Grading Caorridor ﬁﬂ Pipe Metwaork Q Section View _,j: ;_{)‘

Ground Data Design Profile & Section Views Edit Geometry

5-Grading USDA-NRCS 2/23/2012



CIVIL 3D (2010) **REMEMBER TO SAVE OFTEN** 15 of 25

GRADING {Simple and Complex Examples}

¢ Notice how there is some “dead space” between the level section and the start of the channel slope.
Use a 3D Polyline to connect these objects.

Next we need to doctor up the outlet of the channel!
e Draw a circle that starts at the endpoint of the lower elevation line and connects to the
endpoint of the line at the higher elevation.

Center of Circle
1% point picked

/ 7 2+ Point Picked
/ - TR i

e Draw a polyline connecting the 2 points on the outlet elevation (el. 72.0) and the circle
e Trim the remainder of the circle
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...................................................................................................

Vowr dam should novw look similar io this: \

Repeat this same procedure for the inlet channel.
Be sure to check the channel slope!

5-Grading USDA-NRCS
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Now that the inlet and outlet channel slopes are drawn the dam should look similar to this:

We are ready to finish grading the Emergency Spillway!

e Start by drawing three 3D polylines. (see the different colors shown below) over the emergency
spillway channel. We will grade from these 3 sections!
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Let’s start with the easy stuff!

e The blue line is graded at a 3:1 to the existing ground.

.

e The pink line is a little more complicated since we need to create a spillway berm that runs parallel to
the emergency spillway! A cross section of the completed downstream area of the emergency
spillway and spillway berm will look like this:

Top of
Spillway
Berm

Hp + Freeboard >

Width of E.S.
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Start by grading the pink line at a 3:1 up to the top of the spillway berm

e Select the “Grade to Relative Elevation” as the Grading Criteria
e Select the pink line, go through the Create Feature Line dialog box, and follow the
command line.

e Relative Elevation is the Hp + Freeboard (in this example 2.2")
e Slope is typically 3:1

Typically the grading object will not meet exactly at the edge of the dam embankment. There are 2
ways to fix this.

1) Explode the grading object. This results in a 3D Polyline which you can move the end vertex
to the edge of the embankment (be sure to use O-Snap).

OR

2) Click on the daylight line and move the “blue triangle” until the ends line up better.
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We are now going to grade the top of the spillway berm.

Top of
Spillway
Berm
I

e Select the “Grade to Distance” as the Grading Criteria
0 Select either the 3D Polyline (you got from exploding) or the red line of the grading
object (this will depend on what step you did last) and follow the command line.
= Distance is the width of the berm (typically 3-8”) our example uses 6’
= Change the format to GRADE and use 0%

Once again your grading object will not line up exactly with the embankment edge. You will have to
adjust this by exploding and moving the resulting 3D Polyline or by moving the “blue triangle” of the
grading object.

The result so far should look similar to this:
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The last step is to grade the top of the spillway berm at a 2:1 back down the slope.

e Select the “2:1 to Surface” as the Grading Criteria
e Select either the 3D Polyline (you got from exploding) or the red line of the grading
object (this will depend on what step you did last) and follow the command line

You now need to match up the dam embankment daylight line (black line) with the spillway berm
daylight line (green line). You can do this by simply moving the vertices of the black line. If needed
you can edit the black line (PEDIT) and insert vertices to “trace over” the green line. Once finished you
can delete the last grading object (grading from top of spillway berm at a 2:1)

A

S
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The last component of the emergency spillway is grading the inlet channel (the green line)

e The green line is graded at a 3:1, there are 2 ways to do this:
1. Depending on your dam and where your inlet channel is this may be as simple as moving the
embankment daylight line to the end of the inlet channel.
2. Or you may have to create a surface for the dam and daylight to the Dam Surface.

I’ll show you the second option since you can complete the first option with no further help!

e Start by deleting any extra lines you have drawn in, so you don’t accidently pick those.
e Draw in the end of the dam if you haven’t already (pink line in figure below).

¢ Drag the endpoints of your embankment so they meet your grading lines on the end of your emergency
spillway.

e Create a New Surface (name it something obvious like “Dam”)
e Add Breaklines
e Select all the lines that define the dam (grading lines, 3D Polyines, daylight lines, top of
embankment, berm, etc)
e Click “OK” and the surface will be created!
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You’ve probably noticed there are some areas in the surface that could use some “clean up”, areas that

show contours where they shouldn’t be. This is an easy fix!

Change your surface style to “Triangles and Contours” and delete out any unwanted tin lines.
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o Now create a new Grading Group that uses a Target Surface of the DAM Surface.

e Grade the inlet channel at a 3:1 to the Dam
¢ Add the daylight line to the Surface as a breakline

You should have a finished dam!

CIVIL 3D (2010)

You can now complete Profiles, Cross Sections, and add all the dimensions and text you want.
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QUANTITIES

Quantities are done by comparing 2 surfaces (EG vs. DAM).
Analyze Ribbon > Volumes and Materials Tab > Volumes
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e Click on the first button to start a new comparisons
o0 Click under “Base Surface” to get a pull down menu of all your surface
= Choose the existing ground surface
o0 Click under Comparison Surface to get a pull down menu of all your surfaces.
= Choose your new dam surface
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